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Notice
The information in this document is subject to change in order to improve reliability, design, or
function without prior notice and does not represent a commitment on the part of this company.
In no event will we be liable for direct, indirect, special, incidental, or consequential damages
arising out of the use or the inability to use the product or documentation, even if advised of the
possibility of such damages.
No part of this reference manual may be reproduced or transmitted in any form or by any means
without the prior written permission of Trident Microsystems, Inc.

July, 1994

Limited Warranty
This product is warranted against defects in materials and workmanship for a period of one year
from the date of purchase. During the warranty period, product determined by us to be defective
in form or function will be repaired or at our option, replaced at no charge. This warranty does
not apply if the product has been damaged by accident, abuse, misuse, or as a result of service or
modification other than by us.

This warranty is in lieu of any other warranty expressed or implied. In no event shall we be held
liable for incidental or consequential damages, such as lost revenue or lost business
opportunities arising from the purchase of this product.
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CHAPTER 1 - HARDWARE

CHAPTER 1 - HARDWARE

HARDWARE OVERVIEW

Thank you for purchasing this Graphical User Interface (GUI) accelerator
adapter. The adapter works with your 486 or Pentium Peripheral Compo-
nent Interconnect (PCI) Local Bus system to bring you high resolution,
true color capability, high performance, and compatibility with most
software and hardware.

Compatibility

486SX/DX and Pentium PCI systems

Register compatible with EGA and VGA
Non-interlaced or interlaced monitor support
Compatible with Multi-Scanning and PS/2 monitors
1024x768 75Hz refresh

EERAEA

Resolution and Color Selection
B Supports 640x480 in 16, 256, 32K, 64K, and 16M colors
M Supports 800x600 in 16, 256, 32K, 64K, and 16M*™ colors

B Supports 1024x768 in 16, 256, 32K**, and 64K*™ colors
(interlaced and non-interlaced)

Supports 1280x1024 in 16 and 256* colors interlaced
* These modes require 2 megabytes of display memory.

* These modes require 45 nanosecond or faster display memory.

Extended Text Display

M 80 column text modes in 30, 43, and 60 rows
M 132 column text modes in 25, 30, 43 and 60 rows
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Software Drivers Supported

E AutoCAD M Autoshade
E  VersaCAD M GEM Desktop
E Lotus M MS Windows™
M MS Word E 0OS/2 Presentation Manager
i Symphony Ventura
E WordPerfect M SCO
M Quattro Pro M VESA BIOS Extension
(for VESA standard SVGA drivers)
Check List

In addition to this manual, you should have the following:
M GUI Accelerator Adapter Card
Driver & Utility Software

If any of these items are missing or damaged, contact your dealer.

Take this time to record the following information:

Dealer:

Date of Purchase:

Invoice Number:

Dealer's Phone:

Important: Keep all packaging materials that accompany your
adapter in the event you need to return the product.

Technical Support

In the event you have a technical problem, please reference
Chapter 3, “Troubleshooting” of this manual. If you are still unable
to resolve the problem, please contact your dealer for support.
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CONFIGURING YOUR GUI ACCELERATOR

Jumper Settings

You can adapt the GUI accelerator for special hardware configurations
using the given jumpers on the card.

TABLE 1. PCI BOARD JUMPER SETTINGS

JUMPER OFF ON
J4 NON-INTERLACED * INTERLACED

Select Scan Rate: J4

J6 allows you to configure the scan rates of extended VGA modes to be
compatible with your multi-scanning monitor. If your monitor can scan at
48.7 KHz or higher, remove the Jumper pin across J4. J4 in the open
position will allow non-interlaced display for 1024x768 modes and
higher horizontal and vertical scan rates for 800x600-16 and 800x600-
256 color modes. If your monitor cannot scan at 48.7KHz or higher,
leave the Jumper pin for J4 in the default position. This will give
interlaced display for 1024x768 modes and reduced horizontal and
vertical scan rates for the 800x600-16 and 800x600-256 color modes.
Reference Table 2 page 6, and your monitor specifications for more detail
on scan rates.
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INSTALLATION

The installation procedure for your GUI accelerator adapter will vary
slightly depending on the type of system you have (i.e., a 486/Pentium
system with PCI Bus). Follow the general installation instructions in this
section, and look for any special steps you will need to take for your
particular system.

Installation Procedures

To install the adapter into your system, follow these steps:

1. Turn OFF all power to your system, including any peripherals
(printer, external drives, modem, etc.).

2. Unfasten the cover mounting screws on your system. Reference
your system user manual to determine the location of the
mounting screws.

3. Remove the system cover. Reference your system user manual
for instructions on how to remove the system cover.

4. Select an open expansion slot. Select an appropriate PCI Bus
expansion slot for the adapter. Please refer to your computer
system manual for the location of the PCI Bus expansion slot.
Remove the retaining screw that holds the slot cover in place.
Slide the slot cover out and put the screw aside (you will need it
to secure the adapter).

_(Jl

Install the adapter. To install the adapter in the selected PCI Bus
expansion slot, place the gold-fingered edge-connector of the
adapter directly above an expansion slot on the motherboard.

6. Attach the adapter. Use the screw you removed from the
expansion slot in Step 4 to secure the adapter in place.

7. Replace the computer cover. Secure the cover with the mounting
screws you removed in Step 2.

You have now completed the installation of your new graphics adapter on
your system. Before you use the system, however, please refer to the
following section, “Connecting the Monitor”.
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Connecting the Monitoer

The adapter offers a 15-pin analog connector. When you connect your
monitor to the adapter, be sure you have the right cable and cable
connector. Fixed-frequency analog monitors come equipped with a 15-pin
connector. Variable frequency analog or analog/ digital monitors will
require a 9-to-15 pin cable connector.

Monitor Support for Enhanced VGA Modes

Your monitor must be capable of displaying the mode you choose. Table
1 lists all available VGA display modes for the adapter, the monitors
which support them, plus other information that may be useful.

Note that the color palette, (i.e., the total number of possible colors to choose
from), is 16,777,216 in all modes except for monochrome modes where the color
palette is 2--black and the monitor phosphor color. For example, in mode 62 (
1024x768-256 colors), the total colors available for display on the monitor at one
time is 256 different colors from a palette of 16,777,216. In mode 6C (640x480-
16M colors), the total colors available for display on the monitor at one time is
16,777,216, i.e. 24-bit true color
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Table 2. Display Modes

RESOLUTI COLOR REFRESH SCAN MINIMUM ACCELERATIO
ON DEPTH BIT RATE HZ ORDER DRAM MB N SCHEME
X*Y NI g PIAN
640X480 4 60 Ni 12 P
640X480 4 75 NI 1/2 P
640X480 8 60 Ni 12 A
640X480 8 75 NI 112 A
640X480 15116 €0 NI 1 A
640X480 16/16 75 Ni 1 A
640X480 24 60 Ni 1 N
640X480 24 75 Ni 1 N
800X600 4 60 Ni 1/2 P
800X600 4 75 NI 1/2 P
800X600 8 €0 NI 1/2 N
800X600 8 75 NI 1/2 N
800X600 8 60 Ni 1 A
800X600 8 75 Ni 1 A
800X600 15/16 60 NI 1 N
800X600 15/16 75 Ni 1 N
800X600 15/16 60 NI 2 A
800X600 15/16 75 NI 2 A
800X600 24 43 I 2 N
1024X768 4 60 NI 172 P
1024X768 4 75 Ni 112 P
1024X76€8 8 60 NI 1 A
1024X768 8 75 NI 1 A
1024X768 15/16 43 I 2 A
1280X1024 4 43 i 1 p
1280X1024 A 60 Ni 1 P
1280X1024 8 43 1 2 A
1280X1024 8 60 NI 2 A

1. All above modes assume use 80 ns standard DRAM, except those modes need 80 MHz

memory clock will us 45 ns standard DRAM.
Acceleration scheme: P means accelerated by VGA graphic controller. A means

accelerated by graphic engine, and N means partial acceleration.
3. You may need to adjust your multi-frequency monitor to display these modes properly. Use
the horizontal and vertical size and position controls on your monitor to dispiay without

distortion.
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Advanced Topics

The adapter supports a variety of video modes (standard VGA and higher
solution) which are accessible through a video BIOS call from assembly
language or other higher-level programming languages. Reference -
Appendix C for sources of programming assistance.

When you start up in DOS, the screen display defaulis to the standard 80
column text or alpha-numeric mode. This is mode 33 on a color system,
or mode 73 on a monochrome VGA system (see footnote references
immediately following Table 2 above).






Chapter 2 - Software Installation

CHAPTER 2 - SOFTWARE
INSTALLATION

UTILITIES INSTALLATION

Installation Procedures

The Utility Installation program is used to install and retrieve
instructions on:

a) Utility programs.

b) Non Windows applications display drivers.

The Utility installation program is run by executing the following steps:

1. Insert the display driver disk  in the floppy drive.

2. Type in README at the floppy drive prompt.

3. A numbered list of available destination drives will be displayed on
the screen. Select the destination drive by typing in the
corresponding number, e.g. to select drive C, type in 1 (see Figure
10).

4. Files and subdirectories will be expanded into the newly created

directory TVGAUTIL. A new menu will then be displayed on the

screen, showing a list of on-line instructions (see Figure 11).

Selecting A will display the contents of all drivers in the list.

6. Selecting B will display instructions on the available utility
programs.

U

7. Selecting C will display instructions on how to install display drivers

for non Windows applications.

for TUGH Hersion URG.Q 28 ST

B Teant 2MH of heedd disk spape dn epespeiesd for o dinstsl latien.
1. Drive G, 2. Brive Bz, 3. Briue E:
Peivet & pumbeyr { L, 2, 3 0 ¢6 continus: ¢ ESC o Exit >

FIGURE 10.
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|  DRIVERAITILITY for TUGA Uersion UR6.8 21594 ||

fi. Contents
B. TUGA Utilities

C. Display Drivers

Select a letter to continue: ¢ ESC to Exit ) f

FIGURE 11.

Utilities Summary

SVM. EXE

SVM is a menu-driven program designed to select and test all video
modes available to the adapter.

HOW TO USE SVM

The SVM program can be executed in either of two ways: by calling up
the menu and selecting from the menu choices, or by entering the desired
mode directly with a specific command line.

HOW TO USE SVM FROM THE MENU

1. Switch directory to “X:\TVGAUTILAUTILITY” where X is the
drive where Disk 2 of the Trident Utility and DOS Application
drivers have been installed .

2. Type SVM to pull up the menu (see Figure 12).

The top bar shows the available color depths. This is traversed
through by use of the right/left arrow keys.

The program provides all the different resolutions supported by the
chip under each color depth. These resolutions are traversed by the
up/down arrow keys.

The graphics adapter can be tested for each resolution/ mode by first
high-lighting the selection (e.g. 1024x768 256 colors as shown in
Figure 12) by use of the arrow keys, then pressing the F5 key.

10
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The graphics adapter can be run at a selected mode by first selecting the
mode and then pressing ENTER.

B T R T KT

Conmand Line: SUM 62
or SUM 1824x76

Mode Nax. Alpha Display Box
-1 CHex) Colors | Format Size Size

to
FIGURE 12.

HOW TO USE SVM FROM THE COMMAND LINE

The SVM program may be used to select a mode directly from the

command line following two simple steps:

1. Switch directory to “X\TVGAUTIL\UTILITY” where X is the drive
where Disk 2 of the Trident Utility and DOS Application drivers
have been installed.

2. Type in SVM [mode number]ENTER.

For example, to run the graphics adapter in mode 62H, the command for
item 2 above would be:

SVM 62 ENTER
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SMONITOR
SMONITOR is designed to set the moritor group and the monitor type:
Usage: SMONITOR <GROUP|OPTION>

SET MONITOR GROUP

The graphics extended modes set by the graphics card's BIOS are sorted
into six groups categorized by the monitor's refresh rate. The group
setting as below:

GROU TYPE 640X430 800X600 1024X768 1280X1024

P

0 VGA 60 —_ —_ o
1 VGA_ENH 60 871 — —_
2 SVGA 60 56 87l —
3 SVGA_ENH 72 56 871 —
4 SVGA_ENH_NI 72 72 60 871
5 HIFUNC 72 72 70 871
6 OVERHIFUNC — = 75 —_

OPTION:

C  SET COLOR MONITOR
M SET MONCCHROME MONITOR

The default group number is 4.
If you want set the monitor group, type:
SMONITOR GROUP
where GROUP is one of the group number listed above.

SET MONITOR COLOR

Switches between color and monochrome display. Some monitors (most
notably Samsung monitors manufactured before 2/8/91) do not adhere to
the standard IBM pinout definitions, which causes the VGA card to boot
up in monochrome instead of color. This utility may be used to correct
the problem.
To set the monitor as color, type:

SMONITOR C
or type:

SMONITOR M
to set monochrome monitor.

12
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TVGACRTC

The TVGACRTC program allows the adjustment of video display
parameters so that images are optimally sized and centered on the screen.
Adjustable parameters include:

M Horizontal size and position.

M Vertical size and position.

M Pixel frequency.

The program is started from the DOS prompt by typing in TVGACRTC
from the C:\TVGAUTIL\UTILITY directory.

The first section of the program is used to define a given name for the
adjustments to be made (see Figure 14).

e TUGACRIC US.BB(UBRL) Copyright 1993, TRIDENT MICROSYSTEMS, INC. -

No.  Manufacturer : ﬂodel/(v:omment_‘

FIGURE 14.

1. Press ENTER to add a new monitor entry and type in the
name of the manufacturer, followed by ENTER keystroke. The
program will allow any name to be typed in.
2. Type in the associated comments for the monitor settings
and press ENTER.

13
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3. A mode table will be displayed, presenting all the adjustable modes
as shown in Figure 15.

4. This table is traversed through the use of the up/down arrow keys.
The mode highlighted is the selected mode for adjustment.

5. Select the mode to be adjusted and press ENTER (Figure 15 shows
mode "62 non-interlaced" selected).

6. Select the desired pixel rate by scrolling the list (Figure 16) using the
up/down arrow keys and press ENTER twice.

7. The screen alignment test pattern will than be displayed. The
up/down arrow keys are used to adjust the vertical positioning of the
screen. The left/right arrow keys are used for horizontal alignment of
the screen. The home/end keys are used for horizontal screen sizing
and the page up/down keys are used for vertical screen
sizing. Once the screen position and size is adjusted, press
ENTER, followed by the ESC keystroke.

8. To save the settings, type Y and press ENTER. The program will
then modify the Config.sys file.

9. At this point press ESC and reboot the system to enable the
parameter changes.

»*  TUGRCRIC US5.B8¢U8A1) Copyrighf 1923. TRIDENT WICROSYSTEMS,INC. =

MONITOR: .
Type Col. Row Resolution Colors Interlace Loaded Support fAdjust

Graph 168 75 880x608 16 N0 S
Graph 188 37 898608 v B
Graph 128 48  1024x768 e T

48  1024x7%68

FIGURE 15.

14



Hode 62 (Graphics, 1024x768-256, Non-interlaced. '
Freq. Fronm Clock Chip <MHz) Divide By : Result

*72.0
* 75.8
- %78
% 80.0
= §8.0

%980
*108.0
* 118788

~ Press §,. 1, ¢, » and ENIER to select clock chip frequency.
Press PGUP and PGDN  to select 'Divide by'.
ESC —— Return to previous nmenu.
FL — Help.

FIGURE 16.

DRIVER INSTALLATION

After selecting Drivers from the Main Menu, you will be presented with a
list of possible drivers to install. Select the desired driver you wish to
install. You will be presented with a version list for the given application.
Choose the appropriate version of the application. Once you have selected
the desired driver, the installation program will either provide you with
further instructions, or guide you through the installation. The following
pages give details for installing each available driver.

15



Chapter 2 - Software Installation

Microsoft Windows 3.1

INSTALLATION

The graphic installation program (TINSTALL) supports a simple 6 step
installation procedure for the display driver setup program, the power
management program and the UNinstall program.
To use TINSTALL, follow the 6 steps below:
1. Ensure that MS Windows 3.1 is up and running properly,
using the standard VGA driver.
Select the MAIN group in Program Manager.
Click on FILE or press ALT +F.
Click on RUN or press R to select command line.
Type in A:TINSTALL (if the display driver disk is in the B drive
then type in B:TINSTALL) and then press ENTER (see Figure 1).

SIS RO )

Command Line:

|A:TINSTALL |

] Run Minimized

FIGURE 1.

M 6. A menu will appear, presenting a choice of Express or
Custom Installation (see Figure 2).

16



Chapter 2 - Software Installation

Custom Installation

FIGURE 2.

Express Installation is quick and decision free. Display drivers will be
copied into the TRIDENT.AGI directory and Utility files will be copied
into the TRIDENT.UTL directory. Once all files are copied, a program
group called DISPLAY DRIVER AND UTILITIES will be created.

Custom Installation allows control over file storage and in what program
group the icons are placed. The first dialog box that appears shows the
default directory to which the display drivers will be copied. To change
the directory name select the default name, delete it and then enter the
desired directory name. Once the desired directory name is selected,
continue the installation procedure by selecting CONTINUE, or by
pressing ENTER. The next dialog box displays a summary of where files
are stored. Select CONTINUE to copy the drivers and utilities files.
When all files are copied, the program will present a choice of program
groups where the icons will be created. Create a new group to place the
utility icons or select from pre-existing groups (e.g. main, applications,
accessories etc.).

17
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When all necessary files are copied and a group name is selected, the
TINSTALL program will create three icons:

a) Screen Control (Used to configure display drivers).

b) DPMS (Used for power management configurations).

¢) UNinstall (Used to delete the installed TRIDENT drivers).

NOTE: Different “display driver set” versions
cannot be installed to the same directory
name.

“Display driver sets” of the same version number (e.g. UAG6.1) will
replace the existing one.

SCREEN CONTROL

The Screen Control program provides a simplified method to set the
screen resolution, color depth, and fonts. These advanced features allow
customization of the virtual screen parameters and the setting of hot key
values.

The main panel contains controls for setting screen resolution, color
depth, and font size. Not all combinations of screen resolution, color
depth, and font size are possible.

Color depths of 16, 256, 65K, or 16.7M colors can be selected by clicking
next to the desired option. Color depth determines the number of colors
that may be simultaneously displayed on the screen. The selected color
depth deiermines the possible resolutions.

Screen resolutions of 640x480, 800x600, 1024x768 or 1280x1024 can be
selected by clicking next to the available options. The virtual screen size
is automatically adjusted to be at least as large as the selected screen
resolution.

18
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CONFIGURING THE DISPLAY DRIVER

All selections are made by clicking on the available options (see Figure

3).

B Select the color depth first. If the current driver does not support the
selected color depth, then Windows will have to restarted.

B Select the resolution.

B Click on OK. If the current driver does not support the selected
configuration, Windows will have to be restarted.

FIGURE 3.

19
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NOTE: Hot Key Control Should be enabled
before going into advanced setup.
There is no virtual screen support for 16
colors. 1280x1024 is only available for
16 colors.

ADVANCED FEATURES (VIRTUAL SCREEN
CONTROL)

The advanced features of the program is accessed by pressing
ALT + D or by clicking on the box marked Advanced (see Figure 3).

Click to turn on
Virtual Screen

FIGURE 4.

Standard display resolutions are 640x480, 800x600, 1024x768 or
1280x1024. The amount of display memory used depends on the selected
resolution and color depth. For resolutions of 640x480, 800x600 and
1024x768, there is a substantial amount of display memory left unused.
The Virtual Screen features takes advantage of this unused memory by
“expanding” the display area into the off-screen area.

Virtual Screen Control allows the user to make effective use of a display
screen larger than the standard 640x480, 800x600 or 1024x768, and the
standard resolution is the center of the screen. The user can “pan” around
the larger Virtual Screen area by the use of a standard mouse or a set of
“HOT KEYS.” For example, it is possible to select a resolution of
640x480 and set the Virtual Screen size to 800x600. Thus, the 640x480
screen sits at the center of a 800x600 matrix, and the user can “pan”
through the entire 800x600 matrix in a 640x480 window (see Figure 5).

20
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c

Panning allows traversing a larger screen through a smaller window.
' VIRTUAL SCREEN AREA §§ ACTUAL DISPLAY AREA

FIGURE 5.

The advanced features provide functions to customize the virtual screen,
as shown in Figure 6:

Virtual Screen Avance'd Settins

FIGURE 6. DISPLAY DRIVER ADVANCED SETTINGS

21
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VIRTUAL SCREEN ON/OFF

This function activates the virtual screen. When the Virtual Screen is
turned on (Figure 4), (denoted by an X next to "Turn on") a Virtual
Screen Map appears on the designated area. This map shows the actual
Displayable Area, the possible area (i.e. area that can be accessed by
Virtual screen) and the invalid area (inaccessible). The virtual screen size
and shape are selected by dragging the perimeters of the Displayable
area. The "Default Virtual Size" function is then used to align and
maximize the selection (see Figure 6).

FREEZE SCREEN

The Freeze Screen option is used to disable the panning feature, giving
the illusion of a frozen screen but keeping other virtual screen functions
available. Hot key functions are available for this feature.

LINEAR FRAME BUFFER ADDRESS

The Linear Addressing driver will automatically detect the system’s
memory size and sets the frame buffer to an unused area above the system
memory. The Linear Frame Buffer Address setting is useful in avoiding
conflicts with Windows applications which use the same linear frame
buffer address as the Display Driver. Addresses between 18 and 62
MBytes can be selected. If there is no conflict, the default setting is
highly recommended.

BORDER SPACE

The Border Space option is used to set up a border (thickness measured
in pixels) within the Displayable Area, which is used as a marker for
panning the screen, i.e. when the cursor hits against this border, screen
panning occurs (see Figure 7).

22
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B border

Border space sets up a transparent border (black area) on the display area, that is
used as a threshold to start panning the virtual screen.

FIGURE 7.

PAN SET HOT KEY

Hot keys can be set up to pan the virtual screen left, right, up and down.
The feature has to be enabled first by clicking on the ENABLE box,
before hot keys can be selected.

Once all selections are made, click on OK or press ALT + O to exit the
advanced setup.

DPMS (DISPLAY POWER MANAGEMENT
SIGNALING)

The POWER MANAGEMENT program is designed for energy-saving
monitors that conform to the VESA Display Power Management
Signaling (DPMS) standard.

WARNING: The use of this program is not
recommended for monitors that do
not support the VESA DPMS
standard.

The program offers three power-down modes:
1. Standby (minimum power savings)

2. Suspend (substantial power savings)

3. Off state (maximum power savings)
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Display Power Management

FIGURE 8.

The program monitors for mouse and/or keyboard activity. When activity
is not detected for a specified delay period (controlled by the Delay Time
parameter), the program signals the TGUI9440AGi to enter the selected
power-down modes.

The Display Power Management program offers several options to
customize the DPMS operation:

DELAY TIME

The delay time to enter each mode can be sct by entering the value (in
minutes) in the Delay Time parameters. Values can be entered by either
clicking on the count-up or count-down button, or by clicking on the
number, deleting it, and typing in the desired time in minutes (see Figure
9.

Count Up

Count Down

FIGURE 9. DELAY TIME
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ACTIVITY SELECT

The Activity Select option selects which activity the program senses in
order to restore the display to the monitor. For example, if both mouse
and keyboard are selected, then either activity will re-establish the
powered down signals.

PASSWORD OPTION

The Password Option sets up a password to get back onto the screen.

B A password is set up by first clicking on the box marked
PASSWORD PROTECTED or by pressing ALT + P (this is
confirmed by the presence of an “X” in the box).

Press ALT + S or click on the box marked SET PASSWORD.

Type in the selected password (twice) and select OK, or press
ENTER.

CLOCK

Turning on the clock enables the digital count down display.

ALARM

If the Alarm option is enabled, then the last 5 seconds of countdown to
Stand by mode is synchronized with beeps from the PC speaker.

STARTUP ON/OFF

This option installs the Display Power Management program onto the
Windows Startup file, so that DPMS is active upon entering Windows.

DEFAULT

The default button sets all parameters back to the factory default values.

TEST

The test feature is used to give a demonstration of the DPMS power down
function.

%]
%]
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SAVE

This feature is used to save all the current settings.

Once all settings are selected, the program is activated by pressing ALT +
O or by clicking on the box marked Turn On DPMS.

DISPLAY DRIVER UNINSTALLATION

The UNinstall program enables the user to safely delete specific display
drivers or an entire display driver set.

To remove an entire Display Driver Set, complete the following steps:
1. Using the arrow keys or mouse, select the Display Driver Set that is
to be removed (the set to be deleted should be high-lighted).

2. Once the desired Driver Set is selected, simply select the
Delete button or press ENTER.

NOTE: The UNinstall program will not permit the
deletion of a Display Driver set that is
currently in use.

To remove an individual driver from a Display Driver Set, complete the

following steps:

1. Using the arrow keys or mouse, select the Display Driver Set that is
to be removed (the set to be deleted should be high-lighted).

2. Once the desired Driver Set is selected, click on the Enter button.

This will pull up a list of available display drivers.

Select the display driver to be deleted by using the mouse or the

up/down arrow keys to scroll through the list.

4. Click on the Delete button or press ALT + D to delete the selected
display driver.

(98}
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Microsoft Windows NT
MICROSOFT WINDOWS NT 3.1
INSTALLATION

1.

Run the Microsoft Windows NT Setup program located in the Main
group of Program Manager.

Select “Change System Settings”, from the “Options” pulldown
menu.

Select “Other”, from the display options.

Microsoft Windows NT 3.1 will prompt you for the correct path
where the Trident drivers are located. Enter the path
“XNTVGAUTIL\WNTDRVINT31\” where X is the drive where Disk 2
of the Trident Utility and DOS Application drivers have been
installed .

A list of all Trident drivers will appear, select the resolution and
color depth desired.

Restart Microsoft Windows NT. The desired Trident driver will then
be in effect.

NOTE: If you select a color depth or resolution not
supported by your card, NT will substitute
©640x480, 256 color for the display.
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MICROSOFT WINDOWS NT 3.5
INSTALLATION

1.

28

Run the Microsoft Windows NT display Setup program located in
the Control Panel of the Main group.

Select "Change Display Type..." button from the Display Settings
options.

Select "Change..." button from the Display Type options.

Select "Other..." button frem the Select Device options.

Microsoft Windows NT 3.1 will prompt you for the correct path
where the Trident drivers are located. Enter the path
“XATVGAUTILANTDRV\NT31\” where X is the drive where Disk 2
of the Trident Utility and DOS Application drivers have been
installed.

A list of all Trident drivers wili appear, select the resolution and
color depth desired.

Restart Microsoft Windows NT. The desired Trident driver will then
be in effect.

NOTE: If you select a color depth or resolution
not supported by your card, NT will
substitute 640x480, 256 color for the
display.
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Lotus 1-2-3, versions 2.1 and 2.2

1.

SO L A L)

Copy the Lotus 1-2-3 driver into your Lotus directory by running

SET123 from the \TVGUTIL directory. For example, if the

driver/utility is installed in the D: drive and Lotus 1-2-3 is installed

in the C: drive with directory name \LOTUS, type:
D:\TVGAUTIL\SET123 C:\LOTUS

Change to the LOTUS 1-2-3 directory and type: LOTUS to open the

main menu.

Select Install from the main menu.

Select Advanced options from the Install menu.

Select Add new driver to library from the Advanced Options menu.

Select Modify current driver set from the menu.

Select either text or graphics display. For the text mode, choose one

of the following command lines to indicate the number of rows for

your display:

TVGA 132x25 Version ©.x TVGA 80x30 Version x.x
TVGA 132x30 Version x.x TVGA 80x43 Version x.x
TVGA 132x43 Version x.x TVGA 80x60 Version x.x
TVGA 132x60 Version x.x

EXAMPLE: Enter TVGA 132x25 Version 1.0 for
132 column by 25 row display. The
following row values may be used: 25, 30,
43, or 60.

For graphics mode, select the following command line:

TVGA 640x480 for Release 2.x
Return to the Lotus 1-2-3 main menu and choose Save Change to
record the changes, then exit the Lotus 1-2-3 installation program.

10. Installation is complete for Lotus 1-2-3. To reconfigure for a

different resolution (i.e. 132x25 to 132x30 in text mode),
follow steps 3 through 8, then run Lotus 1-2-3 as usual.
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L= g

Symphony 2.x
Copy the Symphony driver to the \SYMPHONY directory by running
the SETSYMPH utility found in the \TVGAUTIL directory. For
example, if the driver/utility is installed in the D: drive and the
Symphony application is installed in the C: drive with a directory
name \SYMPHONY, type:

D:\ TVGAUTIL\SETSYMPH C:\SYMPHONY
The remaining steps need to be completed inside Symphony. Note
them down or reference steps 4 through 9.
Change to the Symphony 2.x directory and type:

SYMPHONY to open the main menu.

Select Install from the main menu.

Select Advanced options from the Install menu.

Select Add New Driver To Library from Advanced Options menu.
Select Modify Current Driver Set from the menu.

Select either text or graphics display. For the text mode, choose one
of the following command lines to indicate the number of rows for
your display:

TVGA 132x25 Version x.x TVGA 80x30 Version x.x
TVGA 132x30 Version x.x TVGA 80x43 Version x.x
TVGA 132x43 Version x.x TVGA 80x60 Version x.x
TVGA 132x60 Version x.x

EXAMPLE: Enter TVGA 132x25 Version 1.0 for 132

10.

11.

30

column by 25-row display. The following
ow values may be used: 25, 30, 43, or 60.

For graphics mode, select the following command line:

TVGA 640x480 for Release 2.x
Return to the Symphony main menu and choose Save Changes to
record the changes, then exit the Symphony installation program.
Installation is complete for Symphony. To reconfigure for a different
resolution (i.e. 132x25 to 132 30 in text mode), follow Steps 4
through 9, then run Symphony as usual.
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GEM Desktop 3.xx

L

Follow the prompts to prepare a GEM/3 driver diskette. The
installation program will copy driver files to the newly formatted
diskette in drive A:.

The remaining steps need to be compieted in side GEM. They are
listed in a text window. Note them down or reference steps 3 through
7.

Insert original GEM/3 system Master Disk, and run "GEMSETUP".
Select in order Change Existing Configuration, Continue, Change
Your Current Setup, and the listed graphics and card display.
When prompted for a new graphics card and display, select Other
Pack and insert the newly prepared GEM/3 driver diskette in drive
A

Select a display driver.

Continue with the rest of the GEMSETUP program. Please consult
your GEM manual for more information on the GEMSETUP
program.
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Ventura Publisher

1

Follow prompts to prepare a Ventura driver diskette. The
installation program will copy driver files to the newly formatted
diskette in drive A:.

Supply the location of the Ventura directory on the hard disk when
prompted (e.g. C:\VP). Enter the path and then select OK.

Indicate whether or not the Ventura Publisher Professional Extension
is being used.

Select one of the display modes listed.

Indicate the type of mouse being used and, if necessary, to which /O
port (i.e. COM1, COM2, etc.) the mouse is connected.

Confirm choices to complete the installation.

To reconfigure for a different display mode, repeat this entire installation
procedure.
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WordPerfect
WORDPERFECT 5.1

TO INSTALL THE TEXT MODE DRIVERS

1. Copy the driver files from \TVGAUTIL\WPS51 directory on your
hard disk drive into your WordPerfect 5.1 directory (e.g. C:\WP51).
For example, if WordPerfect 5.1 is to be installed in drive C: and the
driver\utility is installed in driver D:, type:
Copy D:\TVGAUTIL\UFSI\TVGATEXT.VRS C:\V P51
The display drivers (TVGATEXT.VRS) will be copied automatically
to the WordPerfect directory.

2. The remaining steps need to be completed inside WordPerfect. They
are listed in a text window. Note them or reference steps 3 through 5.

3. Run WordPerfect 5.1 by typing WP at the WordPerfect 5.1 program
directory.

4. Press Shift-FI to bring up the Setup Menu. Press "2" to select
Display and then "3" to select Text Screen Type.

5. Choose one of the extended text drivers. The available drivers are
80x30, 80x43, 80x60, 132x30, 132x43, 132x60.

6. Driver installation is complete for WordPerfect. To reconfigure for a
different resolution, (e.g. 132x25 to 132x30 in text mode), repeat
steps 4 and 5.

TO INSTALL EXTENDED GRAPHICS MODE DRIVERS

1. Copy the driver files from \TVGAUTIL\WPS51 directory on the hard
disk drive into the WordPerfect 5.1 directory (e.g. C:\\WP51). For
example, if WordPerfect 5.1 is installed in drive C: and the
driver\utility is installed in driver D:, type:

Copy D: \TVGAUTIL\WPSI\TVGA16.VRS C:\WP 51

2. The display drivers (TVGA16.VRS) will be automatically copied to
the WordPerfect directory.

3. The remaining steps need to be completed inside WordPerfect. They
are listed in a text window. Note them or reference steps 3 through 5.

4. Run WordPerfect 5.1 by typing WP at the WordPerfect 5.1 program
directory.
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Press the Shift-FI to bring up the Setup Menu. Press "2" to select
Display and the "2" to select Graphics Screen Type.

Choose one of the Extended Graphic drivers. The available drivers
are 800x600-16 colors, 1024x768-16 colors, and 768x1024-16 colors.
Driver installation is complete for WordPerfect. To reconfigure for a
different resolution, (i.e. 800x600), repeat steps 4 and 5.
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WORDPERFECT 6.0
TO INSTALL THE TEXT MODE DRIVERS

1

Copy the driver file from \TVGAUTIL\WP60 directory on the driver
into the WordPerfect 6.0 directory (e.g.\WP6.0). For example, if
WordPerfect 6.0 application is installed in drive C: and the
driver\utility program is installed in drive D:, type:
Copy D: \TVGAUTILAWP60\TVGAG6TXT.VRS C: \WP60
To run WordPerfect 6.0 from the directory, type WP.
Make sure WordPerfect 6.0 Text Mode is selected. There should be a
check mark or an asterisk in front of "Text Mode" under the View
pull-down menu.
Select the "Setup" option under the File pull-down menu,

and chose Display. Select "2. Text Mode Screen Type/ Colors"
and then select "Screen Type". To install the Trident driver, select
"Trident VGA". Select the appropriate screen resolution.

TO INSTALL EXTENDED GRAPHICS MODE DRIVERS

WordPerfect 6.0 for DOS allows selecting either Text Mode or Graphic
Mode Interface. For graphic mode, install the VESA driver and select a
resolution from 640x480 to 1024x768.

1%

If the VGA BIOS on the card is version C3.0 or later, select the
VESA driver that is included in the WordPerfect 6.0 program. If the
VGA BIOS is a version earlier than C3.0, run the VESA EXE utility
program located on the VGA Driver/Utility diskette. Please see
section 2.2.2 for more information on the VESA BIOS Extension
utility.

Make sure the VESA driver from WP6.0 installation program is
selected and installed. Boot-up the WordPerfect 6.0 program, and
select "Graphic Mode" from the View pull-down menu.

Select "Setup"” from the "File" pull-down menu. Select "Display",
and choose "1" to select the different graphic mode driver. Choose
"1" for Screen Type. Highlight "VESA VBE", and select the desired
resolution. Follow the instructions on the screen to complete
installation.

35



Chapter 2 - Software Installation

Microsoft Word for DOS

MS WORD 5.0

1. Copy the MS Word driver from the \TVGAUTIL\Word directory
on the hard drive into the MS Word 5.0 directory (e.g.\Word50). For
example, if MS Word 5.0 is installed in drive C: and the
Driver/Utility is installed in drive D:, type:

Copy D:\TVGAUTIL\WORD\SCREEN.VID C:\WORDS50

The display drivers (SCREEN.VID) will be automatically copied to
the Word directory.

2. The remaining steps need to be completed inside MS Word. They are
listed in a text window. Note them or reference steps 3 through 5.

3. Run MS Word 5.0 by typing “ WORD” in the MS Word 5.0
directory.

4. Press ESC to enter a command. Press “O” to enter an Option
Command.

5. Select Display Mode, then press F1 to list the display modes
available. Choose one of the following lines to indicate the number of
rows for the display:

(1) Text, 25 lines, 16 color  (5) Text, 25 lines, 16 color’
(2) Text, 43 lines, 16 color  (6) Text, 30 lines, 16 color’
(3) Text, 50 lines, 16 color  (7) Text, 43 lines, 16 color®
(4) Text, 60 lines, 16 color  (8) Text, 60 lines, 16 color

"Lines 5 througkh 8 are for 132 column modes. Mouse suppoit is not
available for 132 column modes.

6. Driver installation for MS Word is complete. To reconfigure for a
different resolution, (i.e. 132x25), repeat steps 4 and 5.

MS WORD 5.5

1. Change the directory to \TVGAUTIL\Word55.

2. Type SETUP to run the setup program. Follow the instructions on
the screen to complete the driver installation.
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AutoCAD TurboDLD Classic Driver by Panacea

TurboDLD Classic Driver by Panacea is a combined display interface and
rendering driver. It supports DOS versions of AutoCAD 10/386, 11/386
and 12. It offers the following resolutions for the drawing editor :

640x480 16 colors
800x600 16 colors
1024x768 16 colors
1280x1024 16 colors

320x400 200 colors
640x480 256 colors
800x600 256 colors

1024x768 256 colors (1MB Video RAM required)
1280x1024 256 colors (2MB Video RAM required)

512x480 32k colors
640x480 32k colors
800x600 32k colors
512x480 65k colors
640x480 65k colors
800x600 65k colors

It also offers the following resolutions for rendering:

320x200 256 colors
640x480 256 colors
800x600 256 colors

1024x768 256 colors (1MB Video RAM required)
1280x1024 256 colors (2MB Video RAM required)

512x480 32k colors
640x480 32k colors
800x600 32k colors
512x480 65k colors
640x480 65k colors
800x600 65k colors

To install the display drivers for AutoCAD 10/386, 11/386 or 12, The
UG6.0 DISK # 2 and the proper AutoCAD 386 Release is required.

IMPORTANT: Ensure that AutoCAD is already
installed with the IBM Standard
VGA driver.
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AUTOCAD/386 RELEASE 10 AND 11

j 8

38

Change the directory to CA\TVGAUTIL\ACAD. Type INSTALL
[enter] and follow the installation steps on the screen. The
TurboDLD Classic Driver and the other files will be copied to the
proper ACAD working subdirectory.

Run DLD386's FASTCAD.BAT, or copy the commands from the
file into the AUTOEXEC.BAT file before running AutoCAD.
FASTCAD.BAT sets the environment variables including
DLDCFG, DSPADI, RDPADI and RCPADI.

Start AutoCAD/386 and select Configure AutoCAD from the Main
Menu.

Select, in order, Configure Video Display.

Select ADI P386 v4.0/4.1 display. This will pull up TurboDLD's
configuration menu, which should be used to select the desired
graphics board, resolution.

Select the graphics area background color, text color (for the menu
status line and command prompt areas of the screen), text
background color, border color, and dialog box/button outline color.
To select the default colors, press [Return] at each prompt. To select
a different color, enter the desired color number at the given prompt.
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AUTOCAD/386 RELEASE 12

DISPLAY DRIVER INSTALLATION PROCEDURE

Change the directory to CA\TVGAUTIL\ACAD, and type INSTALL
[enter]. Follow the installation steps on the screen. The TurboDLD
Classic Driver and the other files will be copied to the proper ACAD
working subdirectory.

The display driver for the drawing editor and rendering, is installed by
following these steps:

EDITOR INSTALLATION PROCEDURE
1. Run the AutoCAD Drawing Editor screen.

2. Select CONFIGURE in the File pull-down menu. AutoCAD will
then switch to a text screen.

3. Select 3 to configure the video display. AutoCAD will
then show the current video display.

4. Select Y to select a different driver.

L

Select “Trident Microsystems© Panacea, Inc.”. This will bring out
the TurboDLD's configuration menu.

Follow the menu to select the desired resolution.
Save the selection and exit from TurboDLD's configuration.

Enter 0 to return to the Drawing Editor screen.

Y o

Answer Y to save configuration changes.
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RENDERING INSTALLATION PROCEDURE

“n

2 L 3 o
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Ensure that Rendering for AutoCAD Rel 12 is already installed.

Select Preferences in the Render pull-down menu from the Drawing
Editor screen.

If Rendering has been previously configured, select Reconfigure in
the Rendering Preferences dialog box. Otherwise, the program
automatically will switch directly to a text screen.

Select 2 to configure the rendering driver.

Select "AutoCAD's configured P386 ADI combined
display/rendering driver."

Select the desired resolution for rendering.
Select the desired rendering view
Enter 0 to return to the Drawing Editor screen.

Answer Y to save configuration changes.

Click OK to close the Rendering Preferences dialog box.
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Quattro Pro 2.x for DOS

1.

Copy the Quattro Pro driver from the \TVGAUTIL\PRO directory
on the hard drive into the QPRO 2.x for DOS directory. For example,
if your Quattro Pro 2.x is installed in drive C: and the Driver/Utility
is installed in drive D:, type:

Copy D: \TVGAUTIL\QFRO\VIDEO.RSC C:\QPRO

The display drivers (VIDEO.RSC) will be automatically copied to
the Quattro Pro directory.
The remaining steps need to be completed inside Quattro

Pro. They are listed in a text window. Note them or reference
steps 3 through 5.
Choose to run Q.EXE by entering "Y" in response to the prompt.
The Driver/Utility Installation program will then exit to Quattro Pro.
Press "O" to select the Options menu and "D" to select Display
Mode.
Choose an extended text mode.
The graphic driver installation for Quattro Pro is complete. To
reconfigure for a different resolution, (i.e. 800x600), repeat steps 4
and 5.
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Chapter 3 - Troubleshooting

CHAPTER 3 - TROUBLESHOOTING

The following are some recommended steps to take if the GUI accelerator
adapter will not boot or operate properly in your system:

1.

Check to see if the card is firmly seated in its PCI Bus expansion
slot. Be sure it is not making contact with any other cards in the
system. (Note: Be sure to turn the system off before adjusting the
card.)

Be sure your monitor is properly connected to the card. Be sure
your monitor's pin definitions match those of your GUI
accelerator card.

Turn system on, and be sure that the system's power supply is
operating properly. (i.e. fan operates, system power light turns
on).

43



Chapter 3 - Troubleshooting

COMMONLY ASKED QUESTIONS

44

MCNITORS

Why does the display shift or change sizes when | switch
modes?

Some monitors lack auto-sizing features or just do not
synchronize properly to the video board output. In some
eases, horizontal and vertical display adjustments may be
necessary. Use the TVGACRTC program provided on your
Driver Utility disk to adjust the video board output.
Reference the Software User's Manual for more
information on the TVGACRTC program.

What kind of monitor do I need to display 800x600 or
1024x768 resolution?

To display 800x600 resolution at 56Hz refresh, your
monitor must be capable of a 35.2KHz horizontal scan rate
(e.g., NEC 2A, 3D). At 72Hz refresh, your monitor must be
capable of a 48.0KHz scan rate (e.g., Sony HG 1304, NEC
4D, 5D, Seiko 1450).

To display 1024x768 interlaced, your monitor must be
capable of a 35.5 KHz horizontal scan rate (e.g., NEC 3D,
Seiko 1430 or 1440). To display 1024x758 non-interlaced
(60Hz), your monitor must be capable ofa48.7KHz scan
rate (e.g., SonyHG 1304, NEC4D, 5D, Seiko 1450). To
display 1024x768 non-interlaced (70Hz), your monitor
must be capable of a 56.4KHz scan rate (e.g. NEC 4FG).

What kind of monitor do | need to display 1280x1024
resolution?

A 19-inch or larger size monitor is recommended to display
1280x 1024 (e.g. NEC 4FG). The monitor must also be
capable of a 47.5 KHz scan rate.
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SYSTEMS

Can | have two graphics boards in my system at the same
time?

A monochrome card may co-reside with the VGA adapter.
You cannot have an EGA, CGA, or another VGA card co-
resident.

I see "mouse droppings” on the screen when | move my
mouse a around. Is this a problem with my mouse?

Could be. The version of your mouse driver may not
support VGA. Another possibility is that the DRAM on your
card is not seated correctly or is not the right speed. If you
have added your own DRAM to the card, make sure it is
the same speed or faster than the currently installed
DRAM.
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TROUBLESHOOTING MS-WINDOWS
Problem:  Windows hangs up during or after installing a driver.

Solution A: Reread installation procedures to be sure you have
installed the drivers correctly.

Solution B: Did Windows display an error message before hang-
up?

If no: Check CONFIG.SYS and AUTOE.XEC.BAT files and
minimize TSRs (Terminate and Stay Resident
Programs) or Device Drivers, such as,
DEVICE=MOUSE.SYS in CONFIG.SYS or
PCTOOLS.EXE in AUTOE.XEC.BAT.

If SYSTEM .INI ( located in the WINDOWS\SYSTEM
directory) has been edited, try replacing with a clean
version from the original Windows diskettes. (Note: If
this is done, any other changes you may have made
to SYSTEM.INI will be lost)

Delete and reinstall the driver(s). See NOTE on page
4-X.

If yes: If Windows reports "... file corrupted”, be sure you
have used the Window system or Trident Setup
program to install the drivers. Copying the drivers to
your Windows directory without using the Windows or
Trident directory will result in a file corruption error.
(the files must be expanded as well as copied). If you
use the correct setup program and still have
problems, delete the Trident driver files from your
Windows directory and use a new set of drivers.

If installing on a network via "SETUP/N", you will
need to use the "EXPAND" utility (located on original
Windows diskettes) to expand the display drivers.

Problem:  Garbage on the screen or double images.
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Solution A:

Solution B:

Solution C:

Problem:

Solution:

Problem:

Solution A:

Solution B:

Solution C:

Solution D:

Use View Option (FS) in SVM program to verify the
problem. See Generic Software User's Manual for
more information on SVM program.

Check jumper J4. Be sure the jumper setting is
correct for your monitor.

If the problem persists with the jumpers set correctly,
the board may be defective. Contact your dealer for
further support.

Windows color palette does not look right or colors
changing.

Most likely a defective RAMDAC, memory chip, clock
chip, or crystal. Contact your dealer to have the
problem taken care of.

Can't display certain modes.

Run SVM program (See Software User's Manual for
more information on SVM program). If SVM fails:

Check to see you have enough memory on the VGA
card to run this mode. For example, to run display
modes of 1024x768x25 6 or 32,000 or more colors, 1
megabyte of memory is required.

Run TVGACRTC program to adjust video parameters
(See Software User's Manual for more information on
TVGACRTC program).

If steps a, b, or ¢ do not resolve this problem, it may

be a hardware problem. Check specifications and
capability of the monitor.
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Problem:
Solution A:
Solution B:

Solution C:

Problem:

Solution:

Problem:

Solution A:

Solution B:

Problem:

Solution:

Problem:

48

Windows screen size is too tall or too narrow.
Run SVM to verify the problem.
Use TVGACRTC to adjust screen size.

Some monitors have limited bandwidth and the
Windows screen size problem may not be corrected
completely.

Icons and characters are too small in 1024x768 and
1280x1024 modes.

It is normal for icons and characters to become
smaller in higher resolutions. A 19-inch or larger
monitor is recommended for these higher modes.

Mouse doesn't function properly.
Check mouse connection and re-boot the system.

Contact mouse vendor for latest version of the mouse
driver.

When changing resolutions by running SETUP, the
SETUP menu displays more than one selection for the
same resolution mode.

When upgrading to a new set of Windows drivers, you
need to delete the old OEM?.INF (e.g. OEMO.INF)
file in the WINDOWS\SYSTEM subdirectory. The
SETUP menu will then display only one selection for
each resolution mode.

When installing a high resolution Trident display Driver
for foreign language Windows 3.1 (i.e. German or
French version of Windows 3.1), the SETUP program
prompts to insert an incorrect Microsoft Windows 3.1
diskette.



Chapter 3 - Troubleshooting

Solution:

Since Microsoft uses a different diskette arrangement
for their foreign language Windows 3.1 fonts, the
OEMSETUP.INF in the Driver/Utility Disk will prompt
for a diskette number that is not correct for the foreign
language Windows 3.1. In order to remedy this
problem, a Universal Windows 3.1 driver that includes
all the Windows 3.1 fonts has been created. This
Universal Windows 3.1 driver does not require any
fonts from the Windows 3.1 program diskettes.
Contact your dealer to obtain a Trident Universal
Windows 3.1 display driver diskette.
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Appendics

APPENDICES

Appendix A - Pinout and Sync Frequencies

Analog Color Display Pinouts

Table 2 shows the GUI accelerator analog color display pinouts.

TABLE 2. Analog Color Display Pinouts

PIN FUNCTION

-

1
RED VIDEO

1
GREEN VIDEO

BLUE VIDEO1

NOT USED

GROUND

RED RETURN (GROUND)

GREEN RETURN (GROUND)

BLUE RETURN (GROUND)

Vi|IN|lojlalal W N

KEY (NO PIN)

-
(=]

SYNC RETURN (GROUND)

-t
-

MONITOR ID (NOT USED)

-
N

2
MONITOR ID

-
(2]

HORIZONTAL SYNC

-
e

VERTICAL SYNC

15 NOT USED

Footnotes:

1 Analog monochrome type monitors use green video for all video input and ignore red video

and blue video.

2 Monochrome monitors connect Pin 12 to ground. Color monitors leave Pin 12 open. The
adapter uses Pin 12 to detect the monitor type.
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Conversion Table: 9-to-15 Pin

If you will be using a 9-to-15-pin adapter cable to link your 9-pin monitor
connector to the 15-pin connector, check Table 3 carefully before you
install the cable. 9-to-15 pin adapter cables are available from a variety of
sources, but they need to match the specifications in Table 3 in order to

work properly with your new adapter.

The adapter requires a D-shaped 9-pin female connector and a D-shaped

15-pin male connector.

TABLE 3. 9-to-15 Pin Conversion Table

9-PIN CONNECTOR PIN 15-PIN CONNECTOR PIN
SIGNAL SIGNAL
RED 1 RED 1
GREEN 2 GREEN 2
BLUE 3 BLUE 3
HORZ SYNC 4 HORZ SYNC 13
VERT SYNC 5 VERT SYNC 14
RED GROUND 6 RETURN RED 6
GREEN GROUND 7 RETURN GREEN 7
BLUE GROUND 8 RETURN BLUE 8
SYNC GROUND 9 DIGITAL GROUND 10

Video Signals

ANALOG: BLACK LEVEL =0V

FULL INTENSITY LEVEL = +0.7V
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APPENDIX B - DRAM UPGRADES

Your GUI accelerator adapter may be a IMB DRAM board or an
upgradeable 2MB DRAM board. Please check to see if you have empty
memory sockets to determine which board you have.

Once you have identified your board, you may purchase the same type of
DRAM as is already installed on your VGA addapter. This DRAM may
be purchased from your dealer, a local electronics store, or a mail order
house (which advertise in publications such as Computer Shopper, PC
Magazine, PC World, and BYTE). If you need help, please contact your
vendor.

2MB DRAM Board Upgrade

If your board is identified as an Upgradeable 2MB, it can be upgraded
from IMB to 2MB DRAM. Upgrading to 2MB will allow 1280x 1024-
256 color resolution.

To add DRAM to your board, complete the following steps:

1. Turn system off before removing board.

2. Place the adapter face up on a firm, flat non-static surface (avoid
wool materials). The gold edge connector should be facing you.

3. Insert the DRAM chips into the available sockets on the center of the
board. Be sure pin one on the chip matches with pin one on the
socket. If you install the memory backwards, it will be damaged.
When inserting the chip, be careful not to bend the pins. The DRAM
chip should be seated snugly into the socket.

Upgrade Verification

To check if the DRAM has been installed properly, install the board in
your system and turn the system ON. At the initial boot-up, the copyright
and the amount of video DRAM detected will appear in the upper left-
hand comer of the screen. If the amount of DRAM detected is the same as
the amount installed (2MB), the DRAM has been installed successfully.

If the amount of DRAM detected does not match the amount of DRAM
installed, turn your system off and remove the board from your system.
Check to see that all the pins fit snugly into their respective sockets (i.e.
no pins have been bent underneath the DRAM chip or are sticking out).
Be sure pin one is orientated properly.
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Appendix C - Additional Sources for
Programming Assistance

The information in this manual is intended for quick reference only. If
you intend to seriously program VGA software, you should refer to one of
the following publications on VGA:

e IBM Personal System/2 Display Adapter Technical Reference, April
1987. (IBM part number 68X2251 S68X-2251-0.)

e IBM Personal System/2 and Personal Computer BIOS Interface
Technical Reference, April 1987. (IBM part number 68x2260 S68X-
260-00.)

e Programmer's Guide to the EGA and VGA Cards, by Richard F.
Ferraro. Second Edition, copyright 1990, Addison-Wesley Publish-
ing Company.

e Advanced Programmer's Guide to the EGA, VGA, by George Sutty
and Steve Blair. Copyright 1988, Brady-Book, a division of Simon
and Schuster, Inc.
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Appendix D - FCC Compliance Statement

This device complies with Part 15 of the FCC Rules. Operation is subject
to the following two conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any interference received,
including interference that may cause undesirable operation.

This equipment has been tested and found to comply with the limits for a
Class B digital device, pursuant to Part 15 of FCC Rules. These limits are
designed to provide reasonable protection against harmful interference in
a residential installation. This equipment generates, uses, and can radiate
radio frequency energy and, if not installed and used properly, in strict
accordance with the manufacturer's instructions, may cause harmful
interference to radio communications. However, there is no guarantee
that interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment off and on,
the user is encouraged to try and correct the interference by one of more
of the following measures:

Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that
to which the receiver is connected.

Consult an experienced radio/TV technician for help and additional
suggestions.

The user may find the following prepared by the Federal
Communications Commission helpful: “How to Identify and Resolve
Radio-TV Interference Problems.” This hooklet is available from the U.S.
Government Printing Office, Washington, D.C. 20402, Stock No. 004-
000-00345-4.
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FCC Waming

The user is cautioned that changes or modifications not expressly ap-
proved by the manufacturer could void the user's authority to operate the
equipment.

NOTE: In order for an installation of this product to maintain
compliance with the limits for a class B device, shielded cables and
power cord must be used.
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Appendix E - Software Updates

Trident is continuously working to improve software driver performance,
and to add drivers for new versions of supported application software.
These software updates are available at no charge.

You can connect to the Bulletin Board Service (BBS) at (408) 263-8529,
to learn about new driver software.
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